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About this Guide

About this Guide

This document describes the processes related to planning requirements in project.

Intended audience

Thisdocument isintended for personsin charge of project planningin a company. Consequently, the intended
audience caninclude key users, implementation consultants, product architects, planning team, and support
specialists.

Assumed knowledge

Although you need no detailed knowledge of the LN software to read this guide, general knowledge of the
LN functionality will help you understand this guide.

Document summary

This table shows the chapters of this guide:

Chapter Content

Introduction Provides an overview of the planning and requirement planning
functionality in LN Project.

Activity Structure and activity relation-  Provides information on the usage of the activity structure and

ship in Project activity relationship for planning

Planning in Project Provides information on how to create and maintain plans for a
project

Project Schedule Provides instructions on how to schedule a project

Network Planning Provides information on network planning and critical path analysis
functionality

Baselines in Project Provides information on how to maintain baselines for a project

Planned PRP Orders Provides instruction on how to generate or manually create a
planned PRP order

Planned PRP Purchase Order Providesinstruction on how to create planned PRP purchase order

Planned PRP Warehouse Order Provides instruction on how to create planned PRP warehouse
order
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About this Guide

Chapter Content

Service Orders for Project Provides instruction on how to generate service orders in Project

Resource Planning Provides information on the group planning data and resource
requirements in project

Cost Peg Supplying Relationship Provides information on the cost pegging data between logistics
company

How to read this document
This document is assembled from online Help topics.
Text in italics followed by a page number represents a hyperlink to another section in this document.

Underlined terms indicate a link to a glossary definition. If you view this document online, clicking the
underlined term takes you to the glossary definition at the end of this document.

Contacting Infor

If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and create
a support incident.

The latest documentation is available from docs.infor.com or from the Infor Support Portal. To access
documentation on the Infor Support Portal, select Search > Browse Documentation. We recommend that
you check this portal periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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Introduction

Chapter 1: Introduction

The Planning functionality can be used to maintain the activity structures, financial analysis, and general
planning data as well as to visualize the project schedule and to a project scheduling run.

The Planning and Requirements functionality allows you to plan the project requirements based on the
budget and generate planned orders for procurement and warehousing. The LN project planning allows you
to create a plan and implement the plan in a project. This determines when and where the item is required
in a project. After planning data is generated, the data is used as an input to generate the requirement planning.

The Requirements Planning functionality can be used to generate planned orders for material, equipment
and subcontracting. Such orders can also be entered instead of generated. The Planned purchase orders and
warehouse orders are collectively referred as PRP orders.

Project Requirements Planning

Budget Item Settings Planning
What and hom l' m.;n do we need it?
much do we need? Projects Where do we need it?

Requirements Planning
(PRP)

'

Planned Purchase Orders
Material
Equipment
Subcontracting
Planned Warehouse Orders
Material

To handle the service requirements of projects in progress, Project is integrated with Service. Service orders
can be generated for these projects, based on the reference activity linked to the element or activity. The
project must have the status Free or Active.

Planning and requirements scheduling

Project planning provides the functionality for time-driven budgets, revenues, and unit costs in a project.
Maintenance of planning data, setting up the activity structure and relationships, and performing a financial
analysis is also covered in project planning.

Note:
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Introduction

You can maintain more than one plan for an individual project. For example, to simulate different project
scenarios.

The planned orders can be Purchase Order or Warehouse Order. The Purchase order is transferred and used
in Procurement while the Warehouse Order is transferred and used in Warehousing. You can use the Project
Planning Parameters (tppss0100s000) session to set up the parameters.

These parameters cover whether you want to use plans and if so, the default project plan and details that
relate to the external scheduling package (including currency, time unit, and details of code lengths). The
Project Planning Parameters (tppss0100s000) session includes the default number groups and series used
by the PRP warehouse orders and purchase orders. You can also select the option for inventory checks to be
performed for warehouse deliveries.

Requirement scheduling enables you to generate and maintain the planned orders for material, equipment,
and subcontracting during a project, based on the activity or element control data. The budget type, Project
Control and the planning data is specified for the activity-budget line. You can create the planned purchase
orders or planned warehouse orders using the Generate Planned PRP Orders (tppss6200m000) session.

After these orders are confirmed, you can transfer:

«  Planned purchase orders to (as a purchase order, a request for quotation, or a purchase schedule) to
Procurement

+  Planned warehouse orders to (as a transfer order) to Warehousing

Infor LN displays the planned transactions in the Order Line Balance (Material) (tppss6500m000) session
and the delivery transactions in the Delivered Order Lines (Material) (tppss6550m000) session.

Project requirements planning also includes the rescheduling messages that are generated when the budget
data is modified.

Generate orders using a project requirement planning run from the control data. The control data is aggregated
budget information, for example to focus on certain elements or activities. This data is based on the actual
budget. You define the control data in planning. If you select multiple projects, a control budget is created
for each project.

Note:

You can use an External scheduling package with the planning module to enhance the planning and scheduling
capabilities.

External scheduling packages (ESP) (for example, Microsoft Project) can be used to determine the scheduling
information for activities, budget milestones, OBS elements, and baselines. The ESP currency that is defined
in the Project Planning Parameters (tppss0100s000) session is used in ESP. Most external scheduling
packages do not support multi-currency. If the cost rate of a cost object defined in is in a currency other than
the ESP currency, the rate for the currency is calculated with the Exchange Rate Type of the project definition.
The ESP time unit defined in the Project Planning Parameters (tppss0100s000) session is considered as
the unit for budget lines, such as labor, equipment and subcontracting in the integration.

Infor LN Project Planning and Requirements User Guide | 8



Activity structure and activity relationship in Project

Chapter 2: Activity structure and activity relationship in
Project

This chapter describes the activity structure, activity relationship and milestone.

Using an activity structure

The activity structureis a hierarchical structure thatis commonly used to break a project down into time-scaled
activities.

An activity structure is defined by a reference to the top activity. The hierarchy of an activity structure consists
of all the activities that are displayed under the top activity.

You can use the Activities (tppss2100m000) session to create and maintain activities. You can refine the
hierarchy of the activities by specifying the parent of each defined activity. In the activity hierarchy, you can
define individual activities such as:

+  WBSelement

+  Control account

+  Work package

+  Planning package

Milestones

An activity of zero days that usually represents a significant eventin the project. In many cases the completion
of a phase of major deliverable. Milestones can be used for the moment of invoicing and the calculation of
earned value. Milestones can be linked to activities. A Milestone set to Earned Value Method, enables you to
time-phase the budget by use of a budget version . You can use the Milestones (tppss2101m000) session to
create and maintain milestones. Milestones can also provide feedback related to the progress of customized
items built with a PCS project in Manufacturing. Milestones can also trigger advance payment requests and
installments for invoicing.

Baseline

The baseline is a snapshot of the scheduled activities (active plan) start and end dates for a specific date and
time. You can use the Activity Baseline (tppss2120m000) session to create and maintain a baseline (snapshot)
for activities.
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Activity structure and activity relationship in Project

Note: A WBS element is part of the work breakdown structure, which can be the top of the activity structure.
You can define the project scope in the WBS. At the lower levels of the activity structure, you can use the
Control Account, Planning Packages, and/or Work Packages to define the actual work that is required to
establish the scope.

Activity Relationship

When scheduling a project, the activity relationship is defined to ensure that the activities are sequenced
accurately to provide realistic start and end dates. An activity relationship is a logical relationship indicating
that an activity (successor) cannot start or end until the preceding activity starts or ends. The predecessor or
successor activity can also be a milestone activity. A predecessor task cannot be linked twice to the same
successor task. You cannot create, edit or delete a relationship for projects with Finished, Closed or Archived
status.

Using activity relationship

You can use the Activity Relationships (tppss2510m000) session to define the activity relationship between
the activities of a project. In the session, you can also specify the data such as the plan, activities (successor
and predecessor), relationship type and cost type of the activities. The relationship type of the activities can
have these values:

+  Finish-to-Start: The task initiation of the successor activity is based on the task completion of the
predecessor activity.

+  Finish-to-Finish: The task completion of the successor activity is based on the task completion of the
predecessor activity.

«  Start-to-Start: The task initiation of the successor activity is based on the task initiation of the predecessor
activity.

«  Start-to-Finish: The task completion of the successor activity is based on the task initiation of the
predecessor activity.

Lead timeisthe overlap between the activities with a dependency. You must specify the lead time as a negative
value.

Lagtimeisadelay between the activities with a dependency. You must specify the lag time as a positive value.

You can specify the lead and lag in unit of time or percentage.
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Chapter 3: Planning in Project

The Project Planning Parameters (tppss0100s000) session enables you to set parameters for the project
planning such as the default project plan and details that relate to the External Scheduling.

These sessions can be used to define and maintain plans:

+  Plans (tppss0110m000): You can use this session to set up new plans or to modify the existing plans.

+  Copy Plans (tppss0211m000): You can use this session to copy the details from an existing planto a
new plan.

+ Delete Plans (tppss0210m000): You can use this session to delete a plan or a range of plans.

+  Print Plans (tppss0410m000): You can use this session to print plans in a summary or detailed format.

The information specified for each plan includes details of the top activity linked to the plan, the name of the
planner who initiates the plan, and the planned start and finish dates.

The active plan is visible in the Projects (tppdm6100m000) session. There can be only one active planin a
project. To freeze a budget (control budget), the plan must be Active.

An active plan can be used to:

+  Create baselines
+  Maintain the project progress
+  Orderrequirements

External Scheduling

You can use External Scheduling Packages (such as Microsoft Project) to enhance the planning and scheduling
capabilities in Project. For more information, refer to Infor LN External Scheduling Interface User Guide.
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Chapter 4: Project Schedule

Project Schedule (tppss2700m000) session to select the information that must be considered for visualizing
a projectin a Gantt. The Project Schedule (tppss2700m100) session allows you to view the schedule of the
activities and budget lines by cost types of a specific project or range of projects, in a graphical format. You
can also view the progress of the activity. You can define specific color codes for each status of the project,
based on the color groups specified in the Gantt Chart Colors (tccom5102m000) session. For each activity,
the (planning) progress (Percentage Completed), if any, is displayed as a percentage and as a line linked to
the activity. The percentage is displayed if the Show Completions option on the View menu is selected. An
activity progress line with the related information is also displayed with the activity data.

Note: You can select the data to be displayed in the Project Schedule (tppss2700m100) session (Gantt chart)
from the Project Schedule (tppss2700m000) session.

You can also view this data:

+  Thetop-level production order, schedule and operation linked to the project.

+  The purchase order, production order, work order and the service order linked to the project along with
the project activities and milestones. This results in the integration of the goods and service deliveries
with the contract deliverables and project execution.

+ Theadditional details of the activity budget lines and orders, by resting the pointer over a specific activity.

Note:

+  You can access the Project Schedule (tppss2700m000)) session using various sessions in Project such
as, Project 360 (tppdm6500m100) and Project (tppdm6600m400) sessions.

+  You can use the network planning functionality of the project to plan and schedule a project. You can
also schedule a project manually by moving an activity or chain of activities. The scheduling capabilities
of a Project can be further enhanced using an external scheduling package (such as Microsoft Project).
See: To use an external scheduling package

+  You can use these options in the View menu to personalize the Gantt chart:

+ Show Overdue Activities/Hide Overdue Activities: Allows you to show/hide the overdue activities.

«  Show Markers: Allows you to display the markers.

«  Show Availability: Allows you to display or hide the availability of resources.

+ Show Free Float and Show Total Float: Allows you to display Free Float or Total Float. The total
float and the free float are displayed after (forward planning) or before the activity (backward
planning). See: Float times

+  Markers are displayed for project dates and locations if selected.

«  Theunavailability of resourcesisindicated in the Schedule View and the Gantt View using a specific color.

+ Activity budget information can be accessed from the Gantt View. An activity, activity relationship and
budget can be deleted from the Gantt View.

+  You can use the mouse shortcuts to navigate on the Gantt chart. See: Navigate on the Gantt Chart
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You can perform these actionsin the Project Schedule (tppss2700m000) session and Gantt Chart to schedule
the project:

You can move the activities in the Gantt View only if the Read Only checkbox is cleared in the Project
Schedule (tppss2700m000) session.

If you move the parent activity forward (after the child activity), the child activities also move (based on
the specified schedule constraints) with the parent activity.

If you move the parent activity backward (before the child activity), the child activities also move backward
till blocked by another linked activity.

If you move the child activity before the parent activity, Infor LN adjusts the parent child activity dates.
note: For example, for a Finish-Start relation, the start date is after the parent activity. Therefore, if you
move the child activity backward, that is, if the start date of the child activity is before the finish date of
the parent activity, the session adjusts the start date to the finish date of the parent activity.
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Chapter 5: Network planning

You can use the network planning by critical path analysis functionality, to perform an analysis of activity
relationships and constraints. The planning also helps you to calculate the project duration. The network
planning consists of all the activities required to execute a project. An activity can represent one or more
tasks that are interdependent based on the Relationship Type defined in the Activity Relationships
(tppss2510m000) session. The activity relationships in the network indicate the activities that depend on
each other. The critical path analysis is based on the earliest start date, latest finish date and the float time
(slack) for the project. Infor LN considers the activity relationships, constraints of activities and milestones,
and progress data for the network planning.

This data must be maintained for network planning:

+  General project data

+ Activities for the project
+  Milestones

+  Activity relationships

When you set up network planning, the sequence in which the operations and activities are executed, is
critical. Activities can be executed consecutively or with an overlap.

For a project, you can plan:

+  Forward (based on the start date). The project Start Date must be specified.
+  Backward (based on the finish date). The project Finish Date must be specified.
+  Thisis based on the Planning Method specified in the Project (tppdm6600m400) session

You can modify the Planning Method only if the Project Status is set to Free or Active.

Based on the network planning, the relation between the activities is also used to determine if float time is
applicable for the plan.

Critical Path Analysis

The critical path analysis is used in network planning to determine the optimum route for the project from
the time the first activity starts till the completion of the last activity. An activity is a part of the critical path
if the Total Float and the Free Float fields are set to zero in the Activities (tppss2100m000) session. You
must select the Critical check boxin the Project Schedule (tppss2700m000) session to view the critical path
on the planning board.
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Network planning

If the activity data is modified, the critical path can change. To view the updated data, you must regenerate
the network planning using the Generate Network Planning (tppss2240m000) session.

Float Time:

The critical path analysis considers activity relationships, constraints of activities and milestones, and progress
to calculate:

« Theearliest and latest start and finish dates
+ Freefloattime

+  Totalfloat time

Note: The float time for an activity can vary.

Float types for an activity:

+  Total Float: The number of days for which an activity can be delayed without affecting the next activity.

+  FreeFloat: The number of days for which an activity can be delayed without affecting the project’s start
or end date.

Calculating float time
If the Relationship Type field is set to Finish-to-start in theActivity Relationships (tppss2510m000), the

next activity starts when the preceding activity is completed:

Free float-time (ES)= Earliest start date of the next activity - relation float times - activity
duration - earliest start date

If the Relationship Type field is set to start-to-start in the Activity Relationships (tppss2510m000), the
next activity and the preceding activity start simultaneously:

Free float-time (SS)= Earliest start date of the next activity - relation float times - earliest
start date

The float times are calculated using the Generate Network Planning (tppss2240m000) session. If the value
of both the float times is zero, the activity is a part of the critical path.
Network planning can be performed for the project only if:

+  The Update Mode option in the Plans (tppss0110m000) session is set to update.
«  The Project Status Construction is set to Free or Active in the Project (tppdm6600m400) session.
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Chapter 6: Baselines

Project baselines refer to the scheduled start and end dates of each activity and milestone in an activity
structure on a certain date. The project schedule information on a particular date can be saved for future
reference. Using a baseline, you can compare the scheduled dates set for a baseline and the actual dates to
evaluate the accuracy of the planning. Multiple baselines can be created. You can specify the dates using
these sessions:

+  The Create/Update Baseline (tppss2220m000) session.
«  The Activity Baseline (tppss2120m000) session.
+  The Milestone Baseline (tppss2121m000) session.

A baseline is a snapshot of the scheduled timeline of activities. This can be used to time-phase a top down
budget version using the Generate Time-Phased Budget (tpptc5200m000) session. The time-phased budget
is calculated by using the budget version and the baseline (considering the earned value method, and the
scheduled dates of the activities).

Abaselineis used for performance measurement. To generate performance measurement, the baseline must
be Approved and the budget version must be set to Actual. The amount for a scheduled activity that can be
released depends on the performance measurement period as established in the baseline..

Example

Activity Ahas a distributed amount of a 10,000 euros with the start and End Percentage earned value method.
10% is released when starting the activity, 90% is released at finishing it. The baseline is approved and falls
into two periods. In the first period A starts, therefore an amount of 1000 euros is released for that period. In
the second period when A is finished, an amount of 9000 euros is released. To release the budget amount
Infor LN looks at the baseline data and the Earned Value method.

Creating a baseline

The baseline data depends on the start and end dates of the activity structure or milestones used in a project.
In Planning, you can update a baseline using one of these sessions:

+  Milestone Baseline (tppss2121m000)
+  Milestone Baseline (tppss2121m000)
«  Activity Baseline (tppss2120m000)

From each of these sessions, you can access the Create/Update Baseline (tppss2220m000) session to create
or update a baseline that is based on the activity structure of this specific project.

You can use the Baselines (tppss0520m000) session to view all the baselines of a project and modify the
baseline status. The baseline statuses are:
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+  Free: The baseline is created.
+  Approved: The baseline is approved.

You can only modify the baseline data if the status of the baseline is Free.
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Chapter 7: Planned PRP orders

A planned PRP (Planning Requirement Planning) order is created based on a budget requirement, item
information and dates. It is a planned order advice that you can transfer to Procurement or Warehousing.

You can use the Generate Planned PRP Orders (tppss6200m000) session to generate PRP planned orders.
You can also manually create the PRP Orders using the planned PRP purchase order and planned PRP
warehouse order sessions. If you generate planned PRP orders, Infor LN considers:

+  Existing deliveries

+ Inventory in the project warehouse

+  Project deliverables

+  Transfer orders

+  Purchase schedules

+  Requests-for-quotation (RFQ)

«  Purchase order advices

«  Purchase orders

«  Approved/firm planned PRP purchase orders

«  Approved/firm planned PRP warehouses orders

All planned PRP orders are generated based on the start date of one of:

+ Activity budget line
+ Element
«  Extension

Note: When creating or generating the Planned PRP purchase order, Infor LN defaults the Additional
Information fields from the contract line that is linked to the project peg of the planned order. These are
user-defined fields that can be linked to Infor LN tables.

A planned PRP order for a deliverable originates from the Project Deliverables (tppdm7100m000) session
andisademand forthe project. Thisis an order advice to ship goods either to the project customer to another
project. The planned PRP warehouse order is transferred as a warehouse order with a ship-to business partner.
You can selectif anitemis ordered from the supplier for a project by a PRP Purchase Order or PRP Warehouse
Order or manually using the Project Order System field in the Item - Project (tppdm0105s000) session.

When you generate planned PRP orders, Infor LN considers these deliveries and shipments for a combination
of project, element, activity, item, warehouse and ship-to business partner:

+  Existing firm planned/confirmed deliveries to the warehouse

+  Existing actual deliveries to the warehouse

+  Existing firm planned/confirmed shipments to the business partner
+  Existing actual shipments to the business partner

Infor LN Project Planning and Requirements User Guide | 18



Planned PRP orders

In the Generate Planned PRP Orders (tppss6200m000) session, you can generate planned PRP orders for
material, equipment, and subcontracting. You can split the material orders into purchase orders and warehouse
orders. Equipment and subcontracting are always purchase orders. For standard cost objects, such as items,
Infor LN can consume inventory by using a planned warehouse order before creating a planned purchase
order. This is not possible for the equipment and subcontracting orders.

If you want to track an order, you can view the transactions in these sessions:

« Order Line Balance (Material) (tppss6500m000)
+ Order Line Balance (Equipment) (tppss6501m000)
+  Order Line Balance (Subcontracting) (tppss6502m000)

You can print the transaction data using the Print Planned Transactions by Cost Object (tppss6400m000)
session. If there is a difference between the budget and the ordering of goods or services, Infor LN generates
rescheduling messages that notify the changes required on the actual orders and PRP orders.

Using ATP (available-to-promise) to select alternative

warehouses

The Generate Planned PRP Orders (tppss6200m000) session is enhanced to include the ATP
(available-to-promise) Priorities functionality to enable the selection of alternative warehouses when Multisite
set up is implemented.

For timely delivery of required goods, the selection of the Warehouse(s) that must deliver the goods is crucial.
Infor LN searches for the Priority supply warehouse defined for the Element or Activity or Project. In case of
insufficient ATP in the Priority supply warehouse, Infor LN searches for ATP in alternative Warehouses, which
can belong to different planning clusters.

Priority is assigned to the planning cluster so that warehouses can be selected based on this value specified
for ATP.

ATP priorities are defined based on theDepartment Type in the ATP Priorities (tcmcs0168m000) session.
IftheUse ATP Priorities check box s selected in the Project Planning Parameters (tppss0100s000) session,
foreach Project which has a Project Management Office defined, the ATP priorities functionality can be used
to search for alternative Warehouses.

To use the ATP priority functionality:

+ TheUse ATP priorities check box must be selected and the Priority must be specified in the Project
Planning Parameters (tppss0100s000) session. The Use ATP Priorities and Priority fields are visible,
only if Sites is set to Active and the Enterprise Planning (CP) check box is selected in the Implemented
Software Components (tccom0500m000) session.

«  Foreach Project that must use the ATP Priorities: specify aProject Management Office (Project Office)
in the‘Project’ (tppdm6600m400)session..

»  ATP Priorities must be specified for the Project Management Offices in theATP Priorities (tcmcs0168m000)
session.

«  The Office Type must be set to Project Management 0office in the ‘ATP Priorities’ (tcmcs0168m000).
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The Where Available Check check box in the Generate Planned PRP Orders (tppss6200m000) must
be selected.

The search method used to find alternative warehouses:

Multisite conceptimple- |Project Management Project Management Search method

mented Warehouse used Office specified

No No NA All Clusters

No Yes NA Supplying Relationships

Yes NA No All Clusters

Yes NA Yes ATP Priorities of the
Project Management Of-
fice

Generating Planned PRP Orders

Infor LN allows you to generate a planned PRP order in Project. The planned PRP orders can be a PRP purchase
or PRP warehouse orders. The PRP purchase order is approved and transferred to Procurement and the PRP
warehouse order is approved and transferred to Warehousing.

To generate the planned PRP order:

1
2

10

Access the Generate Planned PRP Orders (tppss6200m000) session.

Select the range of projects in the Selection Range group box on the Options tab. You can click the
Details option to select the additional details for the project.

Select the PRP Warehouse Order Series in the Order Series group box. The PRP Warehouse Orders
Number Group is defaulted from the User Profile (tppdm0101s000) or Project Planning Parameters
(tppss0100s000) session.

Select the PRP Purchase Order Series. The PRP Purchase Orders Number Group is defaulted from the
User Profile (tppdm0101s000) or Project Planning Parameters (tppss0100s000) session.

Select the Process only the Net Changes in the PRP-Run check box if you want to only consider the
data that results when the net change run is performed in the Generate Control Data (tpptc1230m000)
session.

Select the Delete Firm Planned Orders check box if you want to delete the existing firm planned orders.
Select the Approve Planned Orders check box to confirm the planned orders automatically if order date

is in the same period as the time fence. (The time fence starts simultaneously with the generation run).
You can specify the time fence (in days) to confirm the order.

Select the Ignore Rescheduling Messages check box and specify the time fence to ignore the rescheduling
messages.

Select the Apply Order Quantity Increment check box to include and apply the Order Quantity Increment
thatis specified in the Items - Ordering (tcibd2100mO000) session, to the generated planned PRP orders.

Select the Apply Minimum Order Quantity check box to include and apply the Minimum Order Quantity
thatis specified in the Items - Ordering (tcibd2100m000) session, to the generated planned PRP orders.
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11 Selectthe Apply Maximum Order Quantity check boxtoinclude and apply the Maximum Order Quantity
thatis specified in the Items - Ordering (tcibd2100mO000) session, to the generated planned PRP orders.

12 Select the Use Budget Cost Rate as Purchase Price check box to default the budget cost rate as the
purchase price for the PRP purchase order during PRP planning.

13 Select the Copy Text from Budget check box to default the text from the budget line to the Order Text
in the Planned PRP Warehouse Order (tppss6115m000) session or Order Text in the Planned PRP
Purchase Order (Material) (tppss6110m000) session during the PRP planning.

14 Select the Copy Text from Deliverables check box to default the Text from the Project Deliverables
(tppdm7100mO000) session to the Order Text in Planned PRP Warehouse Order (tppss6115m000)
session or Order Text in Planned PRP Purchase Order (Material) (tppss6110m000) during the PRP
planning.

15 Select Also Warnings check box in the Reports group box to include the warnings and errorsin the error
report.

16 Select the Item check box on the Cost Object tab to specify the range of items.

17 Select the Equipment check box on the Cost Object tab to specify the range of equipment.

18 Select the Subcontracting check box on the Cost Object tab to specify the range of subcontracting cost
objects.

19 Select the range of elements in the Structure Range group.
20 Select the range of activities.
21 Click Generate. The PRP warehouse orders and PRP purchase orders are generated.

Using rescheduling messages

Rescheduling messages are displayed when you modify the planning or the delivery dates and provide
information if the orders must be canceled or rescheduled. You can view the rescheduling messages in these
sessions:

+ Rescheduling Messages for Material (tppss6505m000)
+ Rescheduling Messages for Equipment (tppss6506m000)
+ Rescheduling Messages for Subcontracting (tppss6507m000)

You can print the rescheduling message using the Print Rescheduling Messages (tppss6405m000) session.
The rescheduling message options are:

+ Reschedulein
+ Reschedule out
« Cancel

Reschedule in

The order must be delivered earlier because there is a discrepancy between the delivery date on the order
and the required delivery date. This discrepancy can be caused by:

+  The start date of the element (if not available, the project start date) is brought forward.
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«  The start date of the activity budget line is brought forward (either manually or as a result of changes in
the external scheduling package).

+  Thedelivery date of the order is deliberately postponed.

Reschedule out

The order can be delivered later because there is a discrepancy between the delivery date on the order and
the required delivery date. This discrepancy can be caused by:

+  The start date of the element (if not available, the project start date) is postponed.

+  The start date of the activity budget line is postponed (either manually or as a result of changes in the
external scheduling package).

+  Thedelivery date of the order is deliberately brought forward.

Cancel

The order must be cancelled because the quantity of the order exceeds the available quantity. This discrepancy
can be caused by:

+  Reductions in the activity or element budget
+  Cancelation of a budget line
+  Over-ordering

Note: Rescheduling messages are created (again) when you run the Generate Planned PRP Orders
(tppss6200m000) session.

PRP Order History

You can view the order history of a project's purchase and warehouse transactions for materialin the Delivered
Order Lines (Material) (tppss6550m000) session. In addition, you can view the purchase transactions for
equipment and subcontracting in the Delivered Order Lines (Equipment) (tppss6551m000) and the
Delivered Order Lines (Subcontracting) (tppss6552m000) sessions.

The Print Cost-Object Transactions History (tppss6450m000) session provides an overview of the history
of orders delivered to the project. Planned cost object transactions, however, provides an overview of orders
planned in Manufacturing that are either transferred to Warehousing or to Procurement, which are not yet
delivered to the project or the project warehouse.
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Chapter 8: Planned PRP Purchase Order

You can create and manage planned purchase orders, purchase schedules, and requests for quotations in
Procurement.

Planned PRP purchase orders are required to:

+ Order goods
+ Rentanequipment
+  Mobilize subcontractors

The planned orders are generated using the Generate Planned PRP Orders (tppss6200m000) session or
maintained manually (firm planned) in these sessions:

« Planned PRP Purchase Order (Material) (tppss6110m000)
« Planned PRP Purchase Order (Equipment) (tppss6111m000)
+ Planned PRP Purchase Order (Equipment) (tppss6111m000)

Planned orders can be created for material, equipment, and subcontracting (standard and project cost
objects). Only purchase orders can be generated for equipment and subcontracting.

Rescheduling messages

Ifthe budget or planning dates are modified, Infor LN generates rescheduling messages to update PRP orders
or project orders that have already been transferred.

Approve planned PRP purchase orders

You can approve the selected planned PRP purchase orders in the Approve Planned PRP Purchase Orders
(tppss6220m000) session. You can also use the Planned PRP Purchase Order sessions to select and approve
the PRP purchase order. After you confirm the purchase order, you can transfer the order to procurement
and create an actual purchase order. Confirmation means the order has been approved for transfer by the
authorized person or the project manager.

Note: With a time fence you can automatically confirm planned orders that are within the time fence period.

Transfer planned PRP purchase orders

You can transfer PRP purchase orders and/or purchase budget lines (defined in the purchase budget in PTC)
to procurement using the Transfer Planned PRP Purchase Orders (tppss6230m000) session. A planned
purchase order can also be transferred to a planned warehouse order using the Change to Planned Warehouse
Order option in the Planned PRP purchase order sessions.
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Purchase Type for Planned PRP Purchase Orders

Infor LN displays the default Purchase Type for Planned PRP Purchase Orders when you select the Buy-from
Business Partner in the Planned PRP Purchase Order (Material) (tppss6110m000) session. Infor LN uses
this search path to select the purchase type:

1

The Exception Purchase type defined for the Invoice-to Business Partner and the Order Origin of the type
Project. The Exceptions are selected based on the priorities you define.

The Exception defined for the Order Origin of the type All Origin.

The Default Purchase Type of the Financial Business Partner Group linked to the business partnerin the
Invoice-to Business Partner session.

You can change the default Purchase Type or leave it blank.

Using purchase schedules

The purchase schedule functionality is used for items. To process create a purchase schedule from a PRP
purchase order:

1

2

Create Project Requirements Planning Purchase Orders in the Planned PRP Purchase Order (Material)
(tppss6110mO000) session.

Approve the PRP purchase orders using the Approve Planned PRP Purchase Orders (tppss6220m000)
session.

Transfer the purchase orders to Procurement using the Transfer Planned PRP Purchase Orders
(tppss6230m000) session. The orders are displayed as purchase schedule lines in Procurement and you
can manually add extra schedule lines.

To transfer the lines to actual purchase orders, specify the required information for these fields:

«  Apurchase contract for an item in the Planned PRP Purchase Order (Material) (tppss6110m000)
session.

«  The scheduling information in the Ship-to Business Partner session (that you can start from the
Business Partner session).

«  The address data of the project activity in the Activities (tppss2100m000) session. You can define
additional information such as project location, geographical area, GPS co-ordinates and so on.

«  TheShip-to Addressin the Planned PRP Purchase Order (Material) (tppss6110m000) session. The
address code is used in the integration with purchase schedules.

Note:

«  Youcan buy goods for a project location without specifying a warehouse, which means you can
deliver items directly to the project location, while the receipt is handled in Procurement. You can
also buy goods through a project warehouse after which the receipt is handled in Warehousing. The
project warehouse is a warehouse that is completely dedicated to a project. The inventory of the
project warehouse is linked to the project element and activity. The project warehouse cannot be
used if cost pegging is used in a project.

« If goods are delivered to the project warehouse, the address code of the PRP Purchase Order is the
address code of the project warehouse by default.

« Ifthegoodsaredirectly delivered to the location, the Ship-to Address field automatically populated.

Infor LN Project Planning and Requirements User Guide | 24



Planned PRP Warehouse Orders

Chapter 9: Planned PRP Warehouse Orders

You can use the Generate Planned PRP Orders (tppss6200m000) session to generate the planned warehouse
orders based on the projected budget and projected start date You can also manually create these orders in
the Planned PRP Warehouse Order (tppss6115m000) session. A planned warehouse order can be used to
reserve inventory in a warehouse. If the warehouse order is for a customized item, the item is manufactured
and stored in a warehouse.

The PRP warehouse orders are required to manufacture or store goods (materials).

If the delivery date or the budget is modified, you can maintain the updated data for the ordersin the Planned
PRP Warehouse Order (tppss6115m000) session. This session allows you to manually create or modify these
orders from a warehouse to a project or vice versa.

You can peg a PRP Warehouse Order to a project by selecting either of these check boxes:

«  The Mandatory Project Peg check box in the Items (tcibd0501m000) session.
«  The Peg PRP Warehouse Order check box in the Item - Project (tppdm0105s000) session.
«  The Pegging check box in the Planned PRP Warehouse Order (tppss6115m000) session.

For project deliverables, you can use the Generate Planned PRP Orders (tppss6200m000) session to generate
the planned warehouse orders based on the data specified in the Project Deliverables (tppdm7100m000)
session. You can also manually create these ordersin the Planned PRP Warehouse Order (tppss6115m000)
session. You can create orders to:

+  Ship deliverables to a business partner directly or via a warehouse.
« Transfer deliverables to another warehouse.

Approve planned warehouse orders
An actual warehouse order is created when you confirm a planned warehouse order. You can use:

« ThePlanned PRP Warehouse Order (tppss6115m000) session to confirm planned warehouse orders
manually.

+  TheApprove Planned PRP Warehouse Orders (tppss6225m000) session to confirm planned warehouse
orders globally.

+ The Generate Planned PRP Orders (tppss6200m000) session to confirm and transfer the planned
warehouse orders.

Transfer planned warehouse orders

You can use the Transfer Planned PRP Warehouse Orders (tppss6235m000) session to transfer the confirmed
warehouse orders to Warehousing. These transfer orders must be released to allocate inventory to the project.
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Changing planned warehouse orders into planned purchase orders

You can transfer planned warehouse orders to planned purchase orders using the Change to Planned
Warehouse Order option in the Planned PRP Purchase Order sessions. If the cost of transfer between
warehouses at different locations is higher than the cost of ordering the item directly to the project location,
use this session to purchase the item instead of consuming from the inventory in stock. In this scenario, you
must purchase the projectitems and transfer the planned warehouse order to planned purchase order without
updating the planned warehouse order.

Using additional information fields

The additional information fields are user-defined fields that can be linked to Infor LN tables. These fields are
defaulted from the Contract Lines (tpctm1110m000) session to the Planned PRP Warehouse Order
(tppss6115m000) session.

Note:

+  When creating or generating the Planned PRP Warehouse order, Infor LN defaults the additional
information fields data from the Contract Line, that is linked to the project peg of the planned order.

+  Forthe Warehouse Delivery Type wrh->BP or the data specified for the Proj->Wrh->BP Level, sold-to
Business Partner, in the Additional Information Definitions (tcstl2100m000) session is considered
for the contract line. If the Sold-to Business Partner level is not defined, the data specified at the Level,
General is used.

+  Forall other Warehouse Delivery Type, Infor LN only uses the data specified in the Level, General in the
Additional Information Definitions (tcstl2100m000) session.

« Ifyou transfer the Planned PRP Warehouse order to Purchase order or vice versa, the Additional
Information field values are also defaulted.

Combining planned PRP warehouse orders

A planned PRP order is created based on a budget requirement and is an order advise that you can transfer
to Procurement or Warehousing.

Planned PRP warehouse orders generated using the Generate Planned PRP Orders (tppss6200m000) session
or manually created using the Planned PRP Warehouse Order (tppss6115m000), are first confirmed using
the Approve Planned PRP Warehouse Orders (tppss6225m000) session. These confirmed PRP warehouse
orders are then transferred to Warehousing as actual orders.

In Procurement, PRP advises can be combined using the Commingle option, thereby limiting the number of
orders. The Commingling functionality is not applicable for Warehousing. Therefore, each warehouse order
must be processed separately, which incurs some administrative overhead.

You can combine the Planned PRP warehouse orders only if the Combine Orders check box is selected in the
Transfer Planned PRP Warehouse Orders (tppss6235m000) session.

The Planned PRP warehouse orders can be combined into one warehouse order only if:

+  The ship-to and ship-from addresses are the same for all the orders.
+  Planned receipt dates are within a specified time period.
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You can combine the Planned PRP orders as follows:
»  Across Projects

+ By Projects

+  ByElement

+  ByActivity

Example: This table displays the Project, Element and Activity based on which the order combinations are
determined:

check box is Project Element Activity
A X1 Y1
A X2 Y2
A X2 Y1
B X1 Y1
B X2 Y1

This table displays the order combinations and the number of combined orders generated based of the
settings in the Transfer Planned PRP Warehouse Orders (tppss6235m000) session:

Across By Element Activity No.ofcom- Order combinations
Projects  Projects bined or-
dersgener-
ated
Yes -- No No 1 All lines are combined on one order
Yes - No Yes 2 Combined by Y1 and Combined by Y2
Yes - Yes No 2 Combined by X1 Combined by X2
Yes -- Yes Yes 3 Combined by X1-Y1 Combined by X2-Y2
Combined by X2-Y1
-- Yes No No 2
- Yes No Yes 3 Combined by A-Y1 Combined by A-Y2
Combined by B-Y1
- Yes Yes No 4 Combined by A-X1 Combined by A-X2
Combined by B-X1 Combined by B-X2
- Yes Yes Yes 4 Combined by A-X1-Y1 Combined by A-

X2-Y2 Combined by B-X2-Y1 Combined
by B-X1-Y1 Combined by B-X2-Y1
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Project PCS Relationship

A PCS project is a manufacturing project that is created and linked to LN Project using the Project-PCS
Relationships (tppdm6150m000) session. A PCS project can be used to produce a customized item or
standard item. Infor LN allows you to customize the item for a PCS project by selecting the Customizable and
With PCS check boxes in the Item (tcibd0501m100) session. When the item is customized for a PCS project:

+  PRP purchased order is created while running the PRP process, when inventory is not available in the
warehouse.

+  PRP warehouse orders are created while running PRP process, when inventory is available in the
warehouse.

If the PCS item is not customized, PRP warehouse orders are generated using the Generate Planned PRP
Orders (tppss6200m000) session.

Infor LN allows you to print the Project Control System (PCS) planning data for one or more customized items
that are planned for a project. You can use the Print PCS Planning Data (tppss6451m000) session to track
the PRP orders that are created.

Infor LN Project Planning and Requirements User Guide | 28



Service Orders for Project

Chapter 10: Service Orders for Project

You can use the Generate Service Orders (tppss6250m000) session to generate service orders in Project,
based on the budget lines. These budget lines are created based on the reference activity linked to the project
element or activity. To generate service orders, the project status must be set to Free or Active.

You can generate service orders only for:

+  Thebudget lines generated using the Generate Budget from Reference Activity (tpptc2250m000)
session.

+  Thebudget line with start date earlier than the current date + the time fence. For the activity budget
lines, if the budget line start date is not specified, the activity start date is considered.

+  The budget lines for which control data is generated.
Note: This condition is applicable only for projects budgeted and controlled by activity.

Inthe Generate Service Orders (tppss6250m000) session, you can select the projects, elements and activities
for which service orders must be generated. The time fence is used to select the budget lines with the start
date earlier than the current date + the time fence.

Generating service orders

To generate service orders:

1 Specify the Reference Activity in the Elements (tpptc1100mO000) or Activities (tppss2100m000) session
to link the element or activity to the reference activity.
Note: You can link reference activities only of theField service type or the Generatl type that are not
expired.

2 Runthe Generate Budget from Reference Activity (tpptc2250m000) session.

3  Runthe Generate Control Data (tpptc1230m000) session.

4 Generate service orders and service order activity lines using the Generate Service Orders
(tppss6250m000) session. The status of the service order is set to Free.
Note:
« Theorderis processed and costed in Service.

«  When the service order or the service order activity line is set to costed, the costs from Service are
transferred to Project.

«  Youcanview the aggregated cost in the Cost Transactions (tpppc2100m000) session.
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From Invoicing, the service cost is posted to Financials. You can manually link a service order activity
line or a service order to an element/activity/extension in the Service Order Links by Project
(tppss6520m000) session. The cost is added to the Project for the cost objects based on these check
boxes selected in the Field Service Integration group box of the Project Accounting Parameters
(tpppc0100s000) session . Thisis applicable only if the manual links are created for which no mapping
exists:

+ Default Item

+  Default Task

+  Default Equipment

+  Default Subcontracting

+  Default Sundry Cost

«  Default Travel

+  Default Freight

+  Default Helpdesk
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Chapter 11: Resource Planning

Infor LN allows you to maintain the group planning data and resource requirements in Project. You can use
these sessions to view and maintain the group planning, resource requirements and assignments for the
project groups, project activity sets and project activities:

Group Sets for Projects (tsspc2190m300)

Groups for Projects (tsspc3100m400)

Groups for Projects - Dashboard (tsspc3600m600)

Activity List for Projects (tsspc3520m700)

Groups for Projects - Resource Requirements (tsspc3604m900)
Groups for Projects - Proposed Resources (tsspc3604m901)

The Projects Implemented check box must be selected on the Project tab of the Resource Planning
Parameters (tsspc0101m000) session and the Use Assignments check box must be selected in the Settings
tab of the Project Planning Parameters (tppss0100s000) session to use the resource planning for project
groups and activities.

For more information on the resource planning and assignments, refer to:

Infor LN Common User Guide for Resource Management
Infor LN Service Resource Management Workbench User Guide
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Chapter 12: Cost Peg Supplying Relationship

You can use the Cost Peg Supplying Relationships (tppss3130m000) session to link the cost pegs and define
the cost peg supplying relationship data between the logistic companies (receiving and supplying company).
You can transfer goods using warehouse transfers between business units that are used in the different logistic
companies. You can track all costs for both the companies in comparison with another project. So, the
multi-company warehouse transfer can have an outbound as well as an inbound cost peg.

When a planned distribution order or a manual warehouse transfer order is created between two logistic
companies, a valid cost peg is required in the receiving company. Infor LN checks the cost peg supplying
relationships for this cost peg, required for the planned distribution order or the manual warehouse transfer
order. The validation check is based on the receiving and supplying company and the receiving cost peg. The
user authorization must be defined to enable a user to modify the receiving data only in the receiving company
and supplying data only in the supplying company. The user must be provided the required authorization for
Cost Peg Supplying Relationships (tppss3130m000) session and the related company, in the Authorization
Management System. Also, the Cost Peg Supplying Relationship data must be used by the receiving as well
as the supplying company.

To access the Cost Peg Supplying Relationships (tppss3130m000) session, you can use:

« The Cost Peg Supplying Relationships option from the References menu in the Contract Deliverables
(tppdm7100m100) session.

+ TheCreate Cost Peg Supplying Relationship option on the Actions menu in the Contract Deliverables
(tppdm7100m100) session, only if no cost peg supplying relation is defined for the contract deliverable.

The prerequisites to link the cost pegs and create the cost peg supplying relationship between the receiving
and supplying companies:

+  Thereceiving and supplying companies must be logistic companies.
+  The status of the receiving project must be Free or Active.

+  The Project Pegging check box must be selected in the Implemented Software Components
(tccom0100s000) session for the receiving company.

+  Theitem must be cost pegged, that is, the Inherit Project Peg or the Mandatory Project Peg, or both
the check boxes must be selected in the Items (tcibd0501m000) session.

+  Thereceiving and supplying business units must be linked to different logistic companies to transfer the
deliverables between two projects.

Note:
+ Ifyou do not specify the item, the supplying relationship is valid for all items.
+  The cost peg supplying relationships data can be used by both the logistical companies.

+  You can set the status of the supplying relationship line to clesed, in case the supplying relationship is
no longer required.
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Creating the cost peg supplying relationship

For large enterprises consisting of multiple business units, subassemblies manufactured in one business unit
often must be delivered to another business unit in another logistic company. If project cost pegging is
required, all costs must be tracked in both business units against their specific projects. In both companies,
projects are set up, and a cost peg supplying relationship must be defined to establish a link between them.
The cost peg supplying relationship links the demand cost peg from the demand company to the supply cost
peg from the supply company.

To link the cost pegs and create the cost peg supplying relationship:

1 Accessthe Cost Peg Supplying Relationships (tppss3130m000) session.
2 Click New. A cost peg supplying relationship line is created. By default, the line status is set to praft.

3 Select the Item for which the cost peg supplying relationship must be created. This item is transferred
from the supplying company to the receiving company.

4  Select the Receiving and the Supplying companies between which the cost peg supplying relationship
must be defined. Infor LN populates the Creation Date.

Specify the Effective Date and time from when the defined cost peg supplying relationship is effective.
Specify the Expiry Date and time when the defined cost peg supplying relationship expires.
Specify the text related to the cost peg supplying relation, if required.

0 ~N O O

Specify this data for the receiving company in the Receiving Information group box:

a Select the Project of the receiving company. Infor LN populates the current status of the selected
project.

b Select the Element and Activity of the project that receives the item and the cost pegs.

¢ Select the Owner who is responsible for the transaction in the receiving company.

9 Specify this data for the supplying company in the Supplying Information group box:

a Select the Project of the supplying company. Infor LN populates the current status of the selected
project.

b Select the Element and Activity of the project that supplies the item and the cost pegs.

¢ Select the Owner who is responsible for the transaction in the supplying company.

10 Click Submit. The status of the cost peg supplying relation is set to submitted.
11 Specify the supplying cost peg and set the status to completed.
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